
Speedware modernization audit service
To remain competitive in today’s market, 
organizations are undertaking large and 
complex modernization projects designed to 
update aging legacy computer systems and 
improve corporate performance. Depending 
on the size of the organization, these projects 
can cost millions of dollars and take months or 
years to complete. Given the cost and time 
required, successful completion is the goal 
but is often difficult to achieve.

U.S. studies have shown that 18-31% of 
IT-related projects will be cancelled before 
completion and that more than half will incur 
cost overruns of 56-189%. Recent trends show 
some improvement in the absolute success/fail 
rate, but the number of “challenged” projects 
remains consistent over the years: a staggering 
53% of all IT projects are completed late, over 
budget and under scope.

With so much at stake, companies need 
systems to ensure that a modernization project 
is successful. Speedware’s Modernization Audit 
service provides an objective, third-party 
evaluation of your project’s health with 
recommendations for success. 

Speedware’s project audit can uncover the 
issues and challenges typically encountered in 
the execution of an IT project, while focusing 
on producing a successful project result. Our 
evaluation also includes suggestions and best 
practices for improving project organization and 
management. 

Project managers, project stakeholders and 
the project team all benefit from an examination 
of what has gone well and what needs to be 
improved with the project in order to complete 
it successfully.

Contents

1 Speedware 
modernization audit 
service

2 Televised retailer sold 
on Speedware services
Speedware proved that 
even the impossible can 
become a reality

3 Wealth of knowledge 
available in the SWS
Speedware’s Support Web 
Site has the information 
you want

3 GHRUG conference 
University of Houston Clear 
Lake campus hosted 
Greater Houston RUG

3 HP and Encompass 
webcase 
A high-level summary 
on recent developments 
in the e3000 business

4 Media hints ’n’ tips
Improve your Media IQ 
with these ideas from our 
support specialists

6 Where’s the link?
You can put your links 
where you want ’em in 
Speedware Autobahn II

7 Getting the most from 
Speedware versioning
Speedware guru Michael 
Rusk uses versioning to 
update, roll back and 
de-bug

12 AMXW’s new -c 
command line option
Now you can execute 
nlsh commands without 
being in nlsh

June 2008

Volume 18 Number 2

http://www.speedware.com


Volume 18 Number 2 2

The “Customer,” a leader in televised retailing, 
is known as a virtual shopping mall that never 
closes. The company provides telecasts 24 
hours a day, seven days a week, to an 
audience of over 100 million viewers worldwide. 

Time was running out
As a long time Hewlett-Packard customer, this 
retailer already had the largest HP e3000 
machines on site, yet operations were rapidly 
approaching maximum capacity. That, together 
with the announcement that HP would soon 
no longer support the HP e3000, made it 
imperative that a migration solution be found 
and implemented quickly. 

Their internal IT department claimed that, 
due to the complexity of the IT environment, 
a migration solution would be impossible to 
implement within the specified time frame. 

Listening to the customer 
In their search for a migration solution, the 
customer focused on three issues: timing, 
performance and risk.

Of utmost importance to the customer was that 
the migration be completed within a 12-month 
window. The retailer needed a solution that 
would be in place in time to handle the next 
year’s holiday shopping season.

Performance was another high priority as the 
retailer needed to ensure that migrated 
applications would run as fast as the originals 
and that response times would not suffer. 

Finally, the retailer was interested in a low-risk 
solution. With an extraordinary amount of 
information being processed daily, the company 
wanted a migration approach that would ensure 
business continuity.

The complexity challenge
The complexity of this organization’s IT system 
would prove to be the biggest challenge. The 
retailer’s data center stores vast amounts of 
information, up to 19 terabytes of data at a time. 

Adding to the issue of complexity was the fact 
that three separate business operations were 
sharing the applications. There were regional 
differences associated with each of these 
entities and the proposed migration solution 
would have to address these differences.

Speedware’s migration solution
Speedware was awarded the contract not only 
because of their competitive pricing but also 
due to an innovative migration approach that 
zeroed in on the customer’s concerns. 

The proposed migration solution allowed the 
retailer to keep their databases and structures 
without the need to rewrite, helping to ensure 
that the project was completed on time. In 
addition, the solution let the company keep 
certain tools that were vital to their operations.

Highlights of a successful migration
At the end of the migration, both the customer 
and Speedware knew they had accomplished 
what was once considered impossible. 

Speedware completed the migration project on 
time, ensuring that the retailer would be able to 
handle the anticipated spike in holiday 
transactions. Armed with HP Integrity servers 
running HP-UX, reliability was maintained and 
the performance was better than expected. 

In excess of 2 million lines of code were 
successfully migrated. Despite the complexity 
of the project, the transition from the HP e3000 
to the HP Integrity was smooth and business 
continuity was maintained. 

Televised retailer sold on Speedware services 
“We were told this project would be impossible to complete within the allotted time.

Speedware proved that with the right experience, planning and knowledge, even
the impossible can become a reality.”
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Speedware’s Support Web Site (SWS, located 
at www.speedware.com/sws) is a constantly-
growing repository of all things Speedware. 
For example: 

• The SWS gives you access to the entire 
Knowledgebase of service requests, not just 
issues that you have personally submitted to 
Speedware. Every problem, enhancement 
request or technical question submitted to 
Speedware Support is entered into the 
Knowledgebase, which is accessible to all 
supported customers. You can look up the 
status of any reported problem or enhancement 
at your convenience.

• The Documentation folder contains all 
reference manuals, user guides, release notes, 
etc. This folder was previously called the 
Reference Library.

• Technical articles are available in the Learning 
Center folder. 

• A list of bug fixes for a specific software version 
is available by using the Advanced 
Knowledgebase Search. You can get to the 

advanced search by clicking the link in the 
upper-left corner of the initial SWS screen. In 
the advanced search, select a name from the 
Product pull-down list, and specify a version in 
Fixed in Version field. Then click View Results.

In addition to those great features, the SWS 
can also notify you when a patch, new release 
or new documentation is available for 
download. You just have to set Email 
notification to ON in the SWS. 

E-mail notification is set for individual folders in 
the SWS. For example, if you’d like to be 
alerted whenever a new version of classic 
Speedware is released for the HP 9000, just 
open the HP 9000 folder and activate the Email 
notification feature. You can activate this 
feature by clicking the mail icon in the SWS 
toolbar or by clicking the OFF indicator in the 
Email notification line in the upper-right corner 
of the SWS. The indicator will change to ON, 
and email will be activated for the currently 
opened folder.

SWS Guru

Wealth of knowledge available in the SWS
Speedware’s Support Web Site has the information you want

The SWS in brief
• www.speedware.com/sws

• Knowledgebase search 

available from initial screen; 

advanced knowledgebase 

just one click away

• Latest production versions 

of software and 

documentation

• Email notification is 

available per folder in the 

SWS

• What’s New feature lets you 

see what has been added 

since the last time you 

visited the SWS

• Learning Center contains 

hundreds of articles

GHRUG conference
Speedware was a proud sponsor of the second annual 
GHRUG International Technical Conference. The two-day 
event of the Greater Houston Regional Users Group took 
place from March 14-15, 2008 at the University of Houston 
Clear Lake campus.

This year there were five tracks, two of them dedicated 
to the HP e3000. Speedware was pleased to offer two 
presentations: an overview of migration solutions and 
an informative session on Application Portfolio 
Management (APM). 

HP and Encompass webcast 
Speedware was pleased to participate as one of several guest 
speakers in a webcast, providing a high-level summary on recent 
developments in the e3000 business. The webcast, sponsored by 
Encompass and HP, targeted the European market and included 
topics such as news 
and announcements 
as well as what 
customers and 
partners could expect 
in terms of R&D and support over the next few years. The 
webcast took place on Thursday, May 15, 2008, and also allowed 
for discussion on migrations, transition tools and partners.
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Speedware’s Knowledgebase contains 
numerous hints, tips, suggestions and time-
savers that can make you more efficient with 
Media and Media Web. We’ve taken some of 
the best ones and described them below.

Increasing the number of rows returned 
for SQL tables
The number of rows that Media returns in an 
SQL table is determined by the data points 
allowed in charts. A data point is a single value 
in a chart based on an x/y coordinate. For 
example, in a table with 10 rows and 5 columns, 
there are 50 data points. The Media default for 
data points in tables is 2000. To increase the 
number of data points, follow these steps:

1. Right-click the dashboard background (or click 
the File menu) and select Dashboard 
Properties.

2. Click the Charts tab.

3. Under Maximum Number of Data Points, 
increase the value of Table Chart.

Setting the context per user in Media 
Web
You can use a configuration file to set the 
context per user in Media Web. Create the file 
in the same location as the users.dat file 
(repository level). Call it usersettings.ini. The 
file has the following format:

[\data_view_name\dashboard]
user=dimension=value dimension=value, etc.

For example:
[\LBMDemo\LBMdemo.dsh]
admin=Warehouses="New York" Years=05

This specifies context for the user admin. Every 
time an admin user opens the dashboard via 
Media Web, the Warehouse dimension is set to 
New York, and the Years dimension is set to 05.

Selecting language when launching 
Media
Media will follow the regional settings set up 
on your computer to start either in French or 
English. To override the language setting, you 
need to specify the following in the shortcut:

path_to_media.exe /lang:fr

or

path_to_media.exe /lang:en

Avoiding problems with language/
culture on Windows Vista
When you install Media V5.2 on Windows Vista 
and then launch Media, you may see the 
following error:

Unknown culture (en:-US), .NET system default 
used

You simply have to open the shortcut’s 
Properties dialog (see above) and, in the Target 
field, remove any extra colons that were added 
to the line. The target line should be:

path_to_media.exe /lang:en 

Automatically refreshing a chart
If you want a particular chart to be refreshed 
every n minutes, right-click the chart, choose 
Properties from the pop-up menu and click the 
Refresh tab. Select the Automatically refresh 
chart option and then specify how often the 
chart should be refreshed.

Media hints ’n’ tips
Improve your Media IQ with these ideas from our support specialists

Media hints and tips

Media pros use the following 

tricks to speed their use of Media 

and keep their dashboards 

running smoothly. Each item is 

discussed in detail at right.

• Increase the number of 

rows returned for a SQL 

table by increasing the 

maximum data points 

allowed

• Set the context per user in 

Media Web

• Select a language when 

launching Media

• Resolve language/culture 

problems on Windows Vista

• Automatically refresh a 

chart

• Ensure that the introduction 

page always loads when 

running Media Web

• Ensure that users do not 

receive the ‘No more 

licenses available’ message

• Ensure that all data appear 

in a Media chart
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Making sure the Intro.htm page loads in Media Web
When you attempt to load your Media Web V5 page, you may 
notice that you only see a Connect button with no text. For the 
page to load properly, your browser must have JavaScript 
enabled. To enable JavaScript in Internet Explorer:

1. Choose Tools > Internet Options from the main menu. 

2. Click the Security tab.

3. Click on the Custom level... button.

4. Scroll down until you reach the Scripting section. 

5. Enable Active scripting.

To enable JavaScript in Mozilla Firefox:

1. Choose Tools > Options from the Firefox main menu.

2. In the Options dialog, click Web Features. 

3. Click Enable JavaScript.

Once you have made the change, re-load Media Web V5’s 
Intro.htm page. It should display with the proper text.

Dealing with “No more licenses available”
When you attempt to launch Media Web, you click the Connect 
to Server button, but you sometimes receive the following error 
message:

No more licenses available.

This message is usually displayed because Media Web cannot 
reach License Server. You need to check that the IP address in 
the ls.ini file is correct. Follow these steps:

1. Open the ls.ini file found in the following location:

C:\Documents and Settings\All Users\Application Data\
Speedware\Media5\ 

The file contains the following information:

[License]
LSServerIP=ip_address
LSServerPortNum=port_number

2. Make sure that LSServerIP corresponds to the IP address where 
License Server is installed, and LSServerPortNum specifies the 
port on which License Server is listening (8187 by default). This 
information was supplied when License Server was installed. 
You may have to ask your system administrator to check the 
information for you. 

Note that if you specify localhost as the IP address of the License 
Server, you may also receive the error message. It is always best 
to specify the actual IP address of the computer.

Ensuring that all data appear in a Media chart
If you use Media with Decision Server in a client-server setup, you 
may sometimes find that a chart does not include all of the values 
that it displays when you open it locally (without using Decision 
Server). If this happens, try increasing the maximum cache file 
size in Decision Server:

1. Open the Speedware Service Manager.

2. Highlight the appropriate service in the service list. This is the 
service for the repository that contains your dashboard.

3. Click Modify. In the Server Properties dialog, find the Maximum 
cache file size (bytes) field.

4. Increase the file size, and restart the service. 

Vinay Sethi
Technical Support Consultant

Media hints ’n’ tips (continued)
Improving your Media IQ
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Speedware Autobahn II gives you great flexibility in creating 
applications, programs and links. With Autobahn’s wizards, most 
of the work is done for you. Sometimes, however, you might want 
to take the controls and make a few of the decisions yourself. 

For example, have you ever wanted to add a link using the 
Autobahn Link Wizard and wished that it did not always go to the 
bottom of the list of links? Maybe you’d like to use the Link Wizard 
to put the link exactly where you want it to appear on your HTML 
page. With a few easy steps you can add links anywhere on an 
HTML page without going into the Document Editor to move the 
link. Just follow these instructions.

1. Open the Document Editor for the page where you will create the 
link. The Document Editor displays the page’s HTML code.

2. Place the cursor in the HTML at the place where you want the link 
to appear.

3. In the Application Map, draw a link from the program that has the 
Document Editor open to another program.

4. The link code will appear in the Document Editor at the position 
that your cursor was located, instead of appearing at the bottom of 
the page.

This functionality is especially useful when you develop Web 
pages, as you do not have to modify links after they have been 
added. 

Often, you’ll want to embed a link in a paragraph of text, as 
typically happens on Web pages. Autobahn lets you place the 
cursor in the text and create the link at that exact position.

A few gotchas
You can place links wherever you want, but be careful about the 
following:

• When you use this method to create links, all of the link code is 
generated in the spot where you placed the cursor — not in the 
default location. You do not want to have links embedded in other 
code that might change the behavior of your page.

• You should take SPWBLOCKs into account, because they may 
also determine how your link appears or whether it appears at all.

Give it a try. It speeds up and simplifies Web page development in 
Speedware Autobahn.

Tony Aversa
Technical Support Consultant

For a given program, open the Document 
Editor and place the cursor at the spot 
where you want the link to appear. Then 
use the Link Wizard to create the link in 
the Application Map.

In the generated Web page, the link appears 
exactly where you created it.

Where’s the link?
You can put your links where you want ’em in Speedware Autobahn II
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So many times, programmers are asked to remove functionality 
that is “no longer needed...”  Yeah, right! We’ve all heard that one 
before. So the safeguard is just to leave the code in and treat 
those code segments as comments. The problem is that over time 
the program can get so cluttered it’s hard to discern code from 
comments. Why not create a new version of the program with the 
old code stripped out, making it clean and easy to read?

For many, the idea of creating and maintaining multiple versions 
of a program is painful, but keep in mind the benefits:

• It’s easy to roll back to the previous version without having to find 
and strip all of the code out of the program. 

• You can reduce “obsolete” code clutter without losing the code. 

I’m a huge proponent of program versioning and it’s easy to 
implement in Speedware. I was lucky once to meet the gentleman 
responsible for the architecture of Speedware Designer — Steve 
Reeve from London. How Steve saw Designer and the tools and 
capabilities that it provides greatly exceeds the use the average 
customer gets out of the product. This article will provide you with 
some of Steve’s insight so you can benefit from Designer’s 
advantages in program versioning.

Documentation is essential for versioning
Besides being an advocate of program versioning, I’m also big on 
good documentation. I’ve even been branded by some as Mr. 
Documentation just because I'm so obsessive about it. 

As you will see in this article, versioning relies heavily on 
documentation to keep things straight. The way I implement 
documentation is easy — I use templates to get a jump on 
the process when starting a new program. So I’ll discuss 
documentation frequently, but it’s all part of a good versioning 
scheme.

One final note: I know that programmers at most Speedware 
shops insert program intros and change log history at the top 
of the code somewhere. It’s a habit, I know, but there is a much 
better way. For example, let’s say upper management asks you 
to produce a report for a possible audit. The report must list the 
program ID, the name, the program introduction and change log 
and the format, but no program code. Now tell me: can you do this 

without listing the code if the program introduction and change log 
are inline with the actual code? I’m sure you can’t, unless you plan 
to spend long hours at Kinko’s with scissors, glue and a copy 
machine! 

At the end of this article, I’ll show you the exact Sysdoc script to 
get that output, providing you follow my advice and buy into Steve 
Reeve’s vision for Designer.

Screen shots in this article
The screen shots in this article are from Virginia International 
Terminals’ HP 9000 and are just mock-up programs designed 
to illustrate my ideas.

How can you start versioning in Speedware?
Start with the Application Definition screen and make certain 
you are not creating applications with *All in the Program list 
as shown below. 

Also make certain that you are not placing just a few of the 
programs for an application in the program list with the Cascade 
option turned on, as shown below:

Do not use *All. You need to list your programs in AD if you want 
to use multiple versions.

Do not use Cascade. Again, all programs must be listed.

Getting the most from Speedware versioning
Speedware guru Michael Rusk uses versioning to update, roll back and de-bug
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Why these requirements? I'll answer with a question: Did you ever 
wonder what that third column was for in the Application Definition 
Screen? The one called Substitute? Its specific purpose is 
program versioning. But to take advantage of it, every program in 
your application must be in the program list. That way, you know 
exactly which programs are in the given application. More 
importantly, with that list in place, you can substitute a new 
program with a completely different name for any program in 
the application. 

Do you need a new version?
How do you decide when to make a new version of a program? 
There’s no easy answer, since there are many factors to consider. 

Here’s a list of questions I ask when considering whether to create 
a new version as opposed to modifying the existing program:

1. Are there many changes being applied to the program?

2. Are the changes significant?

3. Is the program structure poor and hard to follow?

4. Is the program filled with obsolete code that is commented out?

5. Does the program have a bug and do I need to add traces to 
debug?

Obviously, if you have just a slight change to apply, you might 
quickly make the change to the program and skip versioning it, 
even if items 3 and 4 above are true. Of course, if you have more 
time, and your workload permits, you might take the opportunity to 
create the new version even for the small change, just to achieve 
the cleaner code. 

If number 5 is true, you should create a new version every time. 
You don’t want to clutter up a production program with CREATEs 
to a flat file to trace events and then have to track them all down 
after you have resolved the problem. You simply want a temporary 
debug version that can be used for a specific purpose and then 
replaced by the previous version.

The nuts and bolts of versioning — an example
Is my method of versioning the right way or the best way? I’m not 
certain, but in my years working for Speedware and consulting 
with many of Speedware’s largest customers, I’ve refined my 
method and it always makes the job easier.

The example that I’ll use in the rest of this article is very simple. 
I just want to show the fundamental concepts of versioning in 
Speedware. The main focus will be on a simple customer screen 
with a secondary version of that program along with a customer 
report and its secondary version.

A quick digression about repositories

While we’re on the subject of knowing which programs are in 

a given application, I want to speak to programmers who still 

associate a single repository (design) with each Speedware 

application. Speedware architecture up to and including V5 

dictated one application per design. In V6 the shackle was 

removed, although many developers still hold onto that limiting 

method of using Speedware. 

It is my belief that programmers feel they will lose their programs 

in a vast sea. Isolating “their” pool of programs in a single-

application design seems to be the logical solution. Yes, it is a 

solution, but probably the worst one. Why? Because now you’re 

managing multiple repositories with multiple profiles and multiple 

catalogs, which translates into duplicated database and file 

definitions, and often duplicated programs. Duplication is rarely 

recommended as it creates more work and more problems. 

Steve Reeve created an entity called Category for every object 

in the Speedware repository. 

Once you understand how to effectively use the Category 

feature in Designer you will see how to logically group related 

programs and objects to a specific business function or purpose. 

You can think of it as your logical design within the physical 

design. 

Getting the most from Speedware versioning (continued)
Deciding when a new version is required
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Documentation is the first step
Documentation is crucial to versioning. At the bottom of this page, 
the Program Definition for the Customer screen has the cursor on 
the Sys Doc field. Most programmers don’t name their system 
documentation, but we’ve used the name CUSTSCRNSYSDOC. 
When you use a name, you create an independent document 
object that can be referenced anywhere in Designer. This 
document helps you keep track of your versions.

In fact, once the document is linked to the initial baseline program, 
it will be preserved every time you copy the program to make a 
new version. Even if you have ten versions of the program, they 
will all share the document, which will show all the historical 
changes for each version. Also, no matter which program version 
you open, you see the same documentation and history, as the 
document is linked and shared between all versions! Nice 
concept, isn’t it?

Below at right, part of the CUSTSCRNSYSDOC object is 
displayed. It contains the basic program intro and name with the 
creation date, along with the versioning information showing the 
base version program name and the subsequent version names. 
This is important because the base version is the program name 
that is referenced throughout the application, and Designer maps 
the new version to the old reference. This is what makes versions 
so simple in Speedware — you don’t have to track down all 
references (in menus, function keys, logic, etc.) and change all 
code from CUSTOMERS to CUSTOMERS-V1. Best of all, you 
can start the document from a template, so not only is it consistent 
and useful, it’s easy to create — just fill in the blanks!

Implementing new versions is the second step
After creating new versions of your programs, implement those 
versions in your Speedware application. On the next page, you’ll 
see the Application Definition screen again, but a little differently 
this time. Now the Application lists all the programs in the 
application, which means you can add versions through the 
Substitute field. 

In the Sysdoc document, enter all version information for the 
program so that you always know which is the base version, 
and you know why subsequent versions were created.

In PD, use the Sys Doc field to give your 
document a descriptive name. This 
document will be linked to all versions of 
the program and will serve as a version 
and change record.

Getting the most from Speedware versioning (continued)
Using Sysdoc to keep track of multiple versions
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You can see below that newer versions have been substituted 
for the original programs. When the application is generated, 
Designer inserts the tags SCREEN-CUSTOMERS and REPORT-
CUSTREPORT in the spec file but then maps to the new version 
for all of the code. In the code listing from the spec file, Designer 
inserts comments so that someone picking up the code will know 
where the original version of the code is. And remember: always 
copy the latest version of a program when you create a new 
version and update the documentation accordingly.

User Doc helps too
You should also add version documentation in the application’s 
User Doc. You can always see the versions in the AD list but if the 
application is large you might end up scrolling through many 
screens to find what you need. You can see below the contents 
of the User Doc portion of the VERAPP application. This 
documentation simply lists the original programs and their current 
corresponding versions. Bear in mind that the standard Sysdoc 

report for an application does not show the substitutes. However, 
by placing the information in the User Doc or Sys Doc block, that 
information will be printed in the AREP output.

Obviously, this method of versioning relies heavily on good 
documentation to keep track of what’s in an application. But with 
the tools found in Designer and with a little practice, it will be a 
cinch. The beauty of this strategy is the ability to roll back to any 
previous version simply by inserting the previous version’s 
program name in the Substitute field and re-generating the 
application. If you have only one version to roll back, just remove 
the value in the Substitute field and you are back to the original 
program. 

Ultimately, there may be a point when the original is too outdated 
and you want to clean up your repository. Simply delete the 
original, copy the latest version back to the original name and 
remove the substitute altogether. At that point you will have a new 
baseline program that has all the revisions rolled into it.

Newer versions of programs are 
specified in the Substitute field

The spec file notes where 
the substitutions have 
taken place

User Doc specifies the 
versions currently being used

SCREEN-CUSTOMERS:LISTING;
(* Substituted by CUSTOMERS-V1 *)
(* Release Label (3) *)
SET TITLE ("Customer Master Screen");
SET WINDOW(ROW=2,COL=0,HEIGHT=19,WIDTH=80,LINE=SINGLE,FORE=BLACK, 

BACK=MAGENTA,COORDROW=UP,COORDCOL=LEFT);
... 

REPORT-CUSTREPORT:LISTING;
(* Substituted by CUSTREPORT-V1 *)
(* Release Label (1) *)
SET TITLE ("Customer Report");
SET WINDOW;
DCLPRINTER PRINTER ASSIGN(DEVICE=WINDOW,WIDTH=132,HEIGHT=60);
...

Getting the most from Speedware versioning (continued)
Implementing new versions of your programs
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Sysdoc script
I nearly forgot — at the beginning of this article, I promised you 
the script for a report that lists the program ID, the program 
description, the format and the Sysdoc documentation. This script 
requires you to be licensed for the Sysdoc tools in Speedware. 
These tools help you extract useful information from the repository 
with some simple scripts. At one point, I used Sysdoc and User 
Doc to produce a complete end user manual for an application I 
wrote at American Airlines. The script is shown at the bottom of 
this page.

In this case, the script will list every single program in the 
repository where the Category is equal to “AR” and Program Type 
is a “Report” and it will list the Program Reference, Name, 
Modification Date and Time and the last person to modify the 
program, along with the program format and finally the contents of 
the System Document.

Summing up
This article was an introduction to Speedware’s versioning 
capabilities. There are some basic guidelines you need to follow, 
such as identifying all objects in an application and creating 
decent documentation to help keep track of versions, but beyond 
that, the choices are really yours.

My feeling is that once you start to understand the concepts and 
see what versioning can provide, you will begin to rely on it to 
make your development life much easier. Even if you use it only 
for debugging (where you add code for tracers), versioning is 
worth it. Give it a try soon — you’ll never go back.

Michael Rusk
Virginia International Terminals, Inc.

#HEADING 0,2
Virginia International Terminals
Visual Programs Listing
=============================================================
#ENDHEADING
#FOOTING 2,0
=============================================================
!TIMESTAMP[1:12]
#ENDFOOTING
 
#FOR PROGRAM WHERE '!CATEGORY' = 'AR' AND \
                   '!TYPE' = 'REPORT' ORDER BY REF SELECTED
Program Reference: !REF____________ Program Name: !NAME
Modification Info: !MODTIME___________ !MODIFIER
 
Program Format        
 
#  LISTFORMAT

#  LISTSYSDOC
#ENDFOR

Getting the most from Speedware versioning (continued)
That Sysdoc script I mentioned at the top...
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Did you ever want to execute nlsh commands without actually being in nlsh? Well, starting in AMXW 
V8.05.12, the -c command line option gives you that power. 

The main benefit is the ability to execute nlsh commands from within a UNIX script. The -c command 
line option gives you the possibility of communicating information between the UNIX environment 
and the nlsh environment.

The syntax is one of:

nlsh -c amxw_command 
nlsh INFO="-c amxw_command"

Where amxw_command is:

• Any AMXW command (BUILD, LISTF, etc.)
• !CMD (where CMD is an environment variable already defined) 
• AMXW programs
• UNIX commands
• UDCs
• Command files

The first syntax is normally used from outside nlsh. It can be used inside nlsh or inside a job, but you 
will receive an error message if the nlsh location is set in HPPATH or your current working directory 
is PUB.NEWLAB. The error message is:

This is not a valid keyword for this command. (CIERR 10007)

If you need to use nlsh -c from within an AMXW environment, you can avoid the error either by:

• Using the second syntax (with INFO=), or 
• Removing PUB.NEWLAB from HPPATH and not working from PUB.NEWLAB.

Here is a basic example of a UNIX script called TESTSCRPT that is executed from nlsh and sets a 
global variable in your nlsh environment. The SHOWVAR in nlsh demonstrates that the variable now 
exists in your nlsh environment.

::cat TESTSCRPT
echo my unix script
nlsh -c "SETVAR ABC '123'"
nlsh -c "SHOWVAR ABC"

::TESTSCRPT
my unix script
ABC = 123

::SHOWVAR ABC
ABC = 123

AMXW’s new -c command line option
Now you can execute nlsh commands without being in nlsh

Did you know?
AMXW V8.05.12 includes the 

following upgrades: 

• The -c command line option

• Support for the LIMIT com-

mand on HP-UX and AIX

• Improved spool file handling

• Permission changes

• Enhancements to the COPY 

command

• And many more...

For complete information about 

new features, see the AMXW 

Release Notes 8.05.12, 

available at the Speedware 

Support Web site
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You can also use UNIX piping to combine nlsh commands with UNIX utilities while in nlsh. Here is 
an example that shows how to use a UNIX pipe and grep to find only fixed binary files of a LISTF 
@,2 command.

This example lists all fixed ASCII files that have zero records:

The following example shows how to use UNIX piping to abort all scheduled or executing jobs:

The -c option also supports STDIN and STDLIST arguments to redirect input and output 
respectively using MPE-like keywords. Please note that STDLIST must point to an existing file. 
For example:

Nlsh can also be used as the implicit shell in a UNIX script. Upon execution, UNIX will start nlsh and 
try to execute all the lines that follow. Thus, the script file can contain any command normally 
available at the nlsh prompt. For example:

Tony Aversa
Technical Support Consultant

::LISTF NEW@,2

ACCOUNT=  NEWLAB      GROUP=  DEMO

FILENAME  CODE  ------------LOGICAL RECORD-----------  ----SPACE----
SIZE  TYP        EOF      LIMIT R/B  SECTORS #X MX

NEWFILE           128W  FB           8 1023   1        8  1  *
NEWFILE2 72B FA 4 1023 1 2 1 *

::nlsh -c "LISTF @,2" | grep " FB "
NEWFILE           128W  FB           0       1023   1        0  1  *

Similar to the above example
nlsh -c LISTF @,2 | grep " FA " | awk '{ if ($4 == 0) \
print $1" " $2 " " $4 }'

This example uses the -c option 
and UNIX piping to build a 
command that nlsh finally 
executes with the -c option

nlsh -c SHOWJOB | grep "#J" | grep "SCHED" | awk '{ print "ABORTJOB " $1 }' \ 
| xargs -n2 nlsh -c
nlsh -c SHOWJOB | grep "#J" | grep "EXEC" | awk '{ print "ABORTJOB " $1 }' \
| xargs -n2 nlsh -c

Example using first syntax nlsh STDLIST=OUT -c LISTF NEWFILE,2

Same example with INFO string. 
Note that only the command is 
in quotes in the INFO string

nlsh INFO="-c LISTF NEWFILE,2" STDLIST=OUT
nlsh STDIN=input_file
nlsh input_file Implicit STDIN

The first line, starting with #!, 
identifies nlsh as the interpreter 
of subsequent commands in 
the file

#! ../../NEWLAB/PUB/nlsh
BUILD NEWFILE
touch unixFile
rm unixFile
LISTF NEWFILE,2

AMXW’s new -c command line option (continued)
Using pipes to combine nlsh and UNIX commands

Using the UNIX pipe |, the grep 
command receives the output 
from LISTF @,2 and searches 
for fixed binary (FB) files


